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INTRODUCTION

This is your guide to using the Same Page Systeme.
The Same Page Systeme® serves five distinct and useful purposes. The Same Page® was written to:

Assemble client financial facts through a structured information-gathering process
Organize the information in clear, simple terms

Identify new cross-selling opportunities

Train your successor and/or assistants

Help your client learn to open a conversation with his or her parent about their assets - “parenting
your parents” can be tough.

The final product is the Same Page® Portfolio and the DataKey(s)®:

The Portfolio will include all of the information gathered. The DataKey® is a jump (or flash) drive to which
you have scanned the clients’ advance directives, living wills and durable power of attorney for their health
care. There will be no confidential documents on the DataKey®. This DataKey® will only include the
information the client would need in case of an emergency.

The Same Page System works well for a number of important reasons that benefit both you and your client.
Having an advisor meet with the client ensures that the necessary and complete financial information will
actually be gathered. In the process of gathering the information, cross-selling opportunities will passively
be identified, and then can be presented to the client. And the process of gathering information and
identifying new opportunities works as a good training tool to help your new advisors learn fact-finding
techniques.

On the following pages are the steps involved in delivering the final product to the client. Familiarize
yourself with the flow and the process of gathering the data in this format, and then make adjustments to
fit your own office procedures.



GETTING STARTED

Software Installation

1. Close all open applications and insert the Same 2. Review the License Agreement:
Page Software Installation Disk:

¥ Same Page v.1.0 Setup

¥ Same Page v.1.0 Setup

License Agreement

Flea

Welcome to the Same Page v.1.0 Setup

Welcome to the Same Page v.1.0 Setup Wizard

Mo waiver by either party of any of the terms or conditions of this Agreement:
in any instance shall be deemed or construed to be a waiver of such terms or conditions
For the future or of may subsequent breach thereof, Mor shall any waiver or any default
under this Agreement be construed as a waiver of any other default,

14 If a court of competent jurisdiction hereof holds any term, clause, o provision
of this Agreement to be invalid or unerfarceable, such imvalidity shall not affect the
validity or operatian of any Gther tarm, clauss, or provision of this Agreement; and such
nvalid term, clause, or provision shall be deemed ta be severed from the Agreemert.

ugh the inst

T
w;; a 15, This Agresment constitutes the entire Agresment betwesn the parties, and
may ot be modified or amended by & written instrument executed by sach of the
- parties. This Agresment shal be construed in accordance with the laws of the State of
(Ohin, which hereunder shall gavern disputes, The parties hersta consent to the
jurisdiction of the courts of competent jurisdiction, Federal or state, situated in the State :‘

of Ohio For the bringing of any and all actions hereundr.

Nullsoft Install System v2.29 " ext > ‘I Cancel | Nullsoft Install System v2.29 < Back | 1Agres Cancel

Note: If your auto-run setting is disabled, the Setup Click “I Agree”
Wizard will not start automatically. Simply open “My
Computer” and open the CD Drive containing the Same
Page Installation Disk to start the Setup Wizard.
Click the “Next” button

3. Confirm which components to install: 4. Choose Install Location:

¥ same Page v.1.0 Setup ¥ same Page v.1.0 Setup

Choose Components Choose Install Location

Same Page Exe

cancel | NullsoftInstall Systerm v2.29 <gace [ [0 cancel |

Nullsoft Install System v2.29

Important: Unless you are certain that your system is Note: Same Page v1.0 runs best when installed in the
running compatible versions of .NET and MSSQL, do not C:\ folder.
uncheck these boxes. Click “Next”

Click “Next”



5. Choose Start Menu Shortcut Folder:

¥ same Page v.1.0 Setup

Nullsaft Install| System 220 cancel |

The default folder is “Same Page,” but you may create a

new folder or select a pre-existing folder for the Start

Menu shortcut.

Alternatively, you can choose not to create shortcuts.
Click “Next”

6. Confirm Installation:

¥ same Page v.1.0 Setup

Nullsoft Install System v2.29 <k [0 cancel |

Click “Next” to confirm settings and begin Installation.
This will take approximately 5 minutes to complete, and
the installer will open and close a series of windows
during this time. When installation is complete, leave
the “Run Same Page” box checked and click OK to finish
the setup and register to begin using the software.

7. Register your software in 2 easy steps.
First, generate a Client Code:

2 Client Code Generator

|Jze this form to generate the unigue code for vour Computer.

Generate Code

Mo Code Generated

I ot

Once the code is generated call SamePage Office at 440-358-0605.
'ou will be given a 20 digit code. Uze that code while ingtalling,

Do MNOT uze this code for installation.

i. Click “Generate Code.”

ii. A 16-digit line of text should appear in the box, with
the message “Code Generated Successfully.”

iii. Either select, copy and paste this code and send it in
an email to info@samepageonline.com or call 440-
358-0605 with this number and we will provide the
License Key to unlock your software.

NOTE: You can open the Client Code Generator at any

time from the C:\Same Page Folder or Start Menu >

Same Page Folder.

Click the “Key” icon labeled “ClientKey” and perform

steps i - iii to generate your code.

8. Then, enter your License Key:

File  Help

=10l x|

JRFF-NENF-NFBM-NNAJ-FNBU

Enter Licenze Key:

Format: xxsx-sss- K -nn - Xuns

1] 4 Cancel

i. Open the Same Page Software (if not still open
from the installation process).
ii. Copy and paste or type the 20-digit License Key

provided to you via email and/or phone.

iii. Click “OK.”

iv. Your Same Page Software has been unlocked.
You may login with this information:
Username: admin
Password: admin



THE SAME PAGE PROCESS

From Fact-Gathering to Final Product Delivery

STEP
ONE

Go through the Same Page System with your staff, and set up your Same Page software.

The Same Page System works best when it is done with at least two people -- one person to gather the
information and another to examine it, and confer about the potential selling opportunities uncovered. Of
course, this process can work with one person performing both tasks.

Be sure to read the “Getting Started” Guide in the Portfolio. This is not only a good place to begin with the
client, but also a valuable introduction to the fact-finding process for new advisors and staff.

A. Set up user/password profiles for anyone who will be contributing to the process:

i.
ii.
iii.

Clignts

users
Change Password -m
Print 3
Impark
Advisor Info
Exit

Add I Delete

Manage Users

User Mame: |

Password: I

Confirm Password: I

Save Cancel |

The first time you login, use the Username / Password combination admin / admin
Click on File > Manage Users
Click the “Add” button

iv. Type the User Name and Password in the text fields, click “Save”

B. Customize your Author Page with your company’s information:
Bsametane

MAINTITLE

UPPER RIGHT TITLE

The
Same Page

UPPER RIGHT TEXT

HanTe [

Ugpes Pigre Tl [

Uopm Fight Test: | UPPER LEFT TEXT

Lawet Pight Tt [

Lowste Fight Tt [

Uppm Lot Tate |

gger ot Tet |

Faster } [

Voo 2 | LOWER RIGHT TTLE

Feam [

LOWER RIGHT TEXT

i Click on File = Advisor Info
ii.  Type your information

FOOTER1 ] FOOTERT FOOTERA




STEP
TWO

Gather the Materials

From the Same Page software, print the draft workbook pages to take with you to the client for the first
information gathering session. Choose the specific pages that will be necessary for this particular client. At
different times and with different clients, you will need different sections.

o] Same Page
File | Help

Clients
Manage Users
hange Password

Print » | Elank Document

Advisor Info
Exit PrintReports

The
Same Page

View/Edit

V' advisor Info

(BTSSR  Chris Musgrave
Data / D hering Checklist
’VF Data # Document Gathering Checklist

7 Last Word Forms
¥ Universal Beneficiary Designation Form v Beneficiay Report

¥ Statement OF Clarity v D atakey Request Form

~ Worksheets
¥ Personal Data Warkshest IV Annwity | meentar Wk sheet

¥ Bank Account Inventory Worksheet ¥ Business Interast Inventony waorksheet

¥ Estate Planning Documents Work sheet
Personal Property Inventory Workshest
Medical Insurance "Worksheet
Life Insurance Workshest

Liabilities Inventorp \Worksheet

Income Inventaory 'work sheet
Retirement Plan Inventory Worksheet
Property / Auto Insurance 'Workshest
Investment Inventary Work sheet

Fieal Estate Inventom 'warkshest

Safe Deposit Box Inventary Worksheet

Check Al | UnCheck &1 | Lancel

i. Click on File - Print > Documents

ii. In the pop-up window, check the boxes next to each of the documents you will need.
Or, use the “Check All” button at the bottom to select all worksheets.

jii. At the bottom of the window, click “Print Blank Documents”

Put these blank worksheets into a Same Page System Portfolio to bring to the client’s office or residence.

STEP
THREE

Call the Client

Either the Senior or the Junior financial planner will call the client and explain that you are offering a new
service, the Same Page System. “The Same Page System is a new system that will organize all your
financial information such as policy numbers, beneficiary information, account numbers, locations of loans,
and sources of income in one place.”

Your client knows that you already have many of these pieces of information, and you will explain that
there are probably other things such as homeowners insurance, titles of cars, and other information that
they may not have readily available but would like to have all in one place.
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There are many reasons it will be of value to have all this information consolidated in one program. There
could be a hurricane, fire or flood in the client's home, or the client might not be there to explain things to
the kids, or the parents might not be there to explain everything to the client. This system ensures that in
such a dreadful scenario, all of the clients’ important information will still be available - a solid foundation
upon which to rebuild everything lost in the disaster. In addition, the Same Page System is a valuable
resource in estate settlement. Often, the information is not readily available, and the bereaved are not in a
state of mind to resolve seemingly endless estate matters. Providing a consolidated set of directives
ensures that the client’s wishes are carried out properly. And remember, this system helps to revisit
opportunities that we haven't touched on with our clients in many years.

At the end of the information gathering and
evaluation process, we will deliver a leather portfolio
with all of this information stored in it, and a
DataKey®. Each year, if the client would like, you
will update this information for a nominal fee.

The DataKey® is a small flash drive containing
scanned copies of the advance directives that the
client’s attorney has provided to the client. With the
DataKey® clipped onto their key ring, the most
important information is with the client always.

For example, if the client were to be in a car accident, the responding police officer would take the
DataKey® right from the key chain and plug it into their laptop computer. The necessary documents will be
opened -- contact information, medical records, anything that a client would want a hospital or a police
officer to have. The DataKey® will not have private information on it so that if it were to be stolen or lost,
the client’s privacy would not be compromised.

Although information gathering can be a lengthy process, it is not a complicated process. Explain to the
client that you're going to have your staff person, your junior advisor, or your administrative assistant give
them a call, and go out to see them in their homes possibly two or three times. The assistants are to gather
the information and then they're going to bring it back to the office. The process of gathering information
may take half a day. | have been successful charging $500-$1000 for this step.

After the staff person brings back the information, you, the senior advisor, will examine the information to
make sure everything is complete and up-to-date.

) As you review the information, you will uncover some opportunities to provide
AUTHOR’S . .
NOTE additional services. In several cases we have uncovered blocks of cash, double
D savings bonds, and life insurance policies that had been previously noted with
plans for change but not followed through with.

You may also find that your client has been talking to their Northwestern agent, or that they've been looking
at changing their bank accounts, updating their mortgages, or looking at long-term care insurance. You find
that these are the clients we spend most of our time with and we think that they come to us for everything.
They also think they do, but they just didn't realize we offer those services as well. We have found



investment assets that they've inherited that are dormant, and older brokerage accounts that their parents
left behind. We’ve found stock certificates we didn't even know existed.

Another common opportunity has been finding that when our usual companies de-mutualized (MetLife, New
England, Prudential), most of these clients never actually received their stock. They're held in the
certificate form or electronic form and the clients never received the cash. They've never cashed their
dividends so this money is showing up into unclaimed funds.

This is also a great opportunity to uncover other stocks inherited or about to be inherited.

STEP Go to the Client’s home or office to begin the fact-gathering process.
FOUR

The advisor or staff person takes the portfolio to the client’s home or office with the draft pages printed to
use in gathering the information. A good starting point is to go through the “Introduction” and the “Getting
Started” documents. This will familiarize the client with the steps necessary to gather their information.
Then, with the client and the client’s documents, the advisor fills out the information on the worksheets.
Explain to the client that these worksheets are simply drafts of the final product; after the data is entered
into the Same Page software they will be reprinted and presented in the finished portfolio.

Be sure you have printed the checklist, and keep it handy as you go through the worksheets:

- ‘:m:_ DATA / DOCUMENT GATHERING CHECKLIST

EXISTS LOCATED LosT HOWY R
O1d Tax Returns
Safe Deposit Box & Authorization
Income — Social Security Benefits Proof of Deposit
Income — Civil Service Benefits Proof of Deposit
Income —Yeteran Benefits Praof of Deposit

Income — Pension Benefits Proof of Deposit

4 [=2] o = [o%) 2 —

B T P S B Y .

As noted before, this is a lengthy process, and it will work best for both advisor and client if you stay
organized and gather most, if not all, of the information during the first meeting. Follow-up meetings or
phone calls are almost always necessary, but keeping them to a minimum ensures that the final product is
compiled as smoothly as possible.



STEP Enter the information into the Same Page System
FIVE

Back at the office, the advisor enters the information into the computer using the Same Page System
software.

A. Add a new client to the system:

:ﬂjsame Page - [Clients]
File  Help

The
~a Same Page

[ Clients

bl ione ) Email Address Last Modified
3 [MSKTBIH  |[1Z3MS67091 | smithadFEhalwarth com
1071172007 539 M

Chris Musgrave

Jim Beam 1041142007 4:17 P
Jaohin Maimane 10/17/2007 52 AW
Kathy Jones (E09) 5551212 kjones@yahoo. com

Mike Maimone 1041142007 3:40 &AM

Stewen & Smith E092060238 smithi@albridge. com

Add Client I Edit Client Cancel

i Click File -> Clients to bring up the client list.
NOTE: This list may be sorted by clicking any of the header categories.
ii. Click the “Add Client” button at the bottom.

|:!] Same Page - [Clients]

File  Help

The

WA Same Page
Clierit Marne: | Add Mew Client
w5 amePage0nline. com |

Persanal Data | EheckListI Contact Listl Accounts &Assalsl E state Planning DDCUI‘HEI’]ISI Lastw/ord Fnlmsl Data KE_l,II

Client —Children

Full Name:* SSN: I
Addess [ ©w [

Sl oo 5] 2|
Phone Mumber Home: I Office: I

Ermail Address:l

Driver's License:  gate ISeIect -I Number.

Copy Client Contact Info

Spouse / Partner Copy Client Contact Info Add Child Edit Child |
Name: I
Address: | Citye I Narne:* |
state: ISeIe:t j Zip: I EithDate: I Monday . Ooctober 15 2007 =
Phone Number: o I flffice: I
Email &ddress: I L I
Emergency Contact | Other than Spouse £ Partner Cip I
Mame: | State: ISeIacl j
Felationship: | Zip: |
fua e NmkEES Hoies I Office Phane Numger  Home: | Office: |
Ermnail Address:
I Email Address: I
Save | Cancel

Save | Cancel |

iii. This is the main screen of the client information window.

10



The Personal Data Tab is the starting point for adding client information. Enter basic details such as
Name, SSN, etc. for your client. If contact info is the same for client and spouse, click the “Copy

Client Contact Info” button to automatically fill in the Spouse/Partner info.
If your client has any children, enter the first child’s information on the right side of the Personal Data
Tab. Clicking “Save” will enter the child’s information. Repeat this process until you have entered all
of the client’s children into their profile.

B. Fill

a.
b.
c.

in information on each of the remaining 5 informational tabs:

Checklist
Contact List
Accounts & Assets - Gt [ 2] _hiengi | =
i. Select each item type (Annuity, oo te] o oo o] vedfon| il =
Bank Account, Business Interest, C e =] [ |
Investment, etc.) and click “Add = PRTTRENITT |
New Item” C FE_'
ii. In the pop-up box fill in all known | == The
Lr;fszr:cmatlon about the account or q;;m | |_ Same Page
iii. Click “Save” e |
iv. Choose to add another item of (e A

this type, or close to move on to
another item type.

Cumert Dale: [y7egnecdsy. Ocwbar 24, 2007 -]
Cument Balarce: [Fleaie entet numenict on:.

|
Cortirgent Bermiany. .|...m. .|
Motas: ’—
Save Cancel |
; v
d. Estate Planning Documents - e T VT =
i. Click “Add” s it s R ] o
ii. In the drop-down box, + T - -
WILL VWZA/ANT 302 PH
select the type of e vt e
. | DURADLE POWER OF ATTOANEY 102472007 3102 PH
document (will, trust, [EALTHEARE POWER OF ATTORNEY  PRGY 10/202007 62 P

durable power of
attorney, etc.)

iii. Fill in all information S CiaDssments oot s
o reraderl | , Do 2 | st l—
about the document. L AT i
iv. Click “Save.” e . — e
Whﬂm! ‘what happens io the Dwncrrhip?- I
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Last Word Forms -
i. Select the Form Type (Universal Beneficiary Designation, Statement of Clarity,
Beneficiary Receipt or DataKey Request Form) and click “New”
ii. For each type, follow the on-screen prompts and fill in all information possible.
iii. The DataKey Request Form is a document that will go on the client’s DataKey and
contain all necessary emergency information:

— Datakey Request Form
Pleaze add the following public information which can be viewed by anyone accessing the Datakey. Use additional sheets if necessany.

Mame: [lim Miller Address: 2525 Ashbrook Dr.
City: |sp,ingﬁe|d State: ISeIect j
Zip [12345 Phone Number: [555.123-4567
Ermergency Contact M ame: IJane Miller Emergency Contact Phone: |555_1 23-6789
Frimary care Physician: ID" Fat Callires Frimary care Phyzician Phone: |555_1 234321

Prescribed Medications:

Allergies: IF'en\c:lIIln, Lequrnes, Shellfish : INone

Copies of Living ‘Wil & Health Additional Information:

care power of Attarney: IDn D ataley |B|00d Type: O+

C. The final tab is the Data Key Tab. See Step Eight.

After entering all of the information gathered on the first visit, the advisor will probably need to make
follow-up phone calls to clarify information or to gather additional information.

STEP
SIX

Print out the drafts and confer with Senior Advisor to identify new opportunities

Following a similar process as in Step 2, go to “File - Print” and select the documents you would like to
print for review, or click “Select All” to print the entire portfolio contents. Click “Print.” The senior
advisor will examine the information as well as begin to identify and uncover new service opportunities.

Alternatively, you may choose not to print the documents yet, and instead review them on your computer
screen. At the bottom of the Print window, click the “Save” button to export all of the selected forms in MS

Word format. The documents will appear exactly how they will print.

STEP
SEVEN

Contact the Client with new suggestions.

Following the conversation between a senior financial planner and the staff member who gathered the
information, newly uncovered opportunities can be presented. This proactive approach, based on each

client’s individual financial status, will engender confidence in the financial planners’ ability to manage the

client’s finances.
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STEP Scan the documents for the DataKey®.
EIGHT

Scan the advance directives from the client’s attorney. Keep track of each client’s documents in a
separate client folder to ensure you can locate them easily.

These pages can then be copied onto the DataKey®:

Clierit Name: [ ann- Smith | AddMew Client |

Personal Data I CheckList | Contact List I Accounts & Assets I Estate Planning Docurents I Lastwford Forms  Data Key
— Data Key

File Path: | |

— File Names
File Path

C:ADocuments and Settir imone. COMC Jocum e P
CADocuments and Settings‘\Mike Maimone COMCORDADYISOR S \My DocumentshS ame P
CADocumentz and SettingziMike Maimone CONCORDADWISOR S e DocumentzhS ame

Copy Selected Files to Datakey

i Click on the final tab in the Client Information Screen, labeled “Data Key”

ii.  Press the button labeled “...” to browse for the scanned files.

iii. In the pop-up box, browse to the folder on your computer that you scanned this client’s
documents into. Select the file and click “Open.”

iv.  Once all of the files are listed under “File Names,” select all of them by clicking the top file,
hold SHIFT, and then click the bottom file.

v.  Once all files have been selected (the lines should turn blue) click “Copy Selected Files to
DataKey”

STEP Print out the final portfolio contents for the client.
NINE Deliver the Same Page System® Portfolio with DataKey™.

The finalized Portfolio pages can be printed directly from the Same Page System as described in steps Two

and Six. If updates to specific pages are needed at any time, those pages can be printed out separately and
given to the client.

Insert the final printed copies of the materials into the leather Portfolio, and place the DataKey in its
holder. Present the finished Same Page System to your client.
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ALBRIDGE IMPORT

An internet connection is required for Albridge Import.

1. Open the Albridge Import Window:
Click on File - Import

2a. Enter your Partner User ID:
Provided by Albridge. Contact us for information on obtaining your Albridge Import Partner User ID.

2b. Enter search criteria. Search by Social Security # or by client name:
The search process can take several minutes, depending on the speed of your internet connection and how

many users are accessing records on the Albride database.

What would you like to Import? —————— [ Search

% |mpaort Client Details SSH: |

| Refresh &ceount Holdings and Fositions Firzt M anme: I

Fartner User Id: |aa-2400 Last Mame: ISmith
| Search | Cloze Impaort

3. Select your client(s) to import into the Same Page Software:

‘ ‘ ! Search | Close Impart

SSN | Full Name | Address City State zip Pome Hice Email Select
» LsaCSmih |23 HothJea.. | Tucson 0z 12345
Faye Srith 23 Quenin ... |Easllake oH aa76s O
David& Smith {1234 MorthJea.. | Tucson 4 12345 O

4. Classify client accounts accordingly in drop-down boxes.
To skip importing an account, leave “Do Not Import” selected. Click Save.
Note: Any information that is unavailable or incorrect in the Albridge database, such as Account Type or Name,

can be edited in the client’s file.

‘ | L ‘ Search | Cloze Impart |

[ Account Holdings

ﬁﬁfnil‘g:t n::“t:unl Account Type Total Yalue Price Date Account
1234567 INVESTMENT 23561.3M62 11/2/2007 2:51:03 PM Do Mot Impart j

9876543 INVESTMENT 72609.36 11/2/2007 Z51:09PM | Investment j
5361.53024 11/2/2007 25110 FM

Investment e

INVESTMENT

3451237

Do Mot Import
Annuity
Business Interest
Fi

tPlan

R
Bank &ccount

Save Cancel
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